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Introduction
This is a free supplementary document available from the Dolphin Learning Zone. It is part of the Microsoft Excel 365 Desktop Edition with SuperNova and Dolphin ScreenReader support pages.
This document contains the keyboard commands you use to complete many popular tasks in Excel 365, alongside the SuperNova and Dolphin ScreenReader hotkeys that may assist.

Enhance Excel with sounds
You can enhance your experience using Excel by enabling sounds. When enabled, sounds will reinforce many of the common actions you perform such as deleting, cutting, pasting, and actions like autocorrection, opening task pane, and closing task pane.
When enabled, the sound effects are used in all Microsoft Office apps irrespective of the app you chose to turn them on.
To enable sounds:
1. Open Excel, Outlook, PowerPoint, or Word.
2. Open the "File" menu and select "Options" (ALT + F, T).
3. Select the "Accessibility" category.
4. Select "Provide feedback with sound" check box (ALT + S).
5. TAB to and select a sound scheme. You can choose between two different sound schemes: Modern and Classic.
6. Select the "OK" button.

Hotkey conflicts
[bookmark: _Hlk151035208]You may experience a hotkey conflict with some of the stated keyboard commands. If you are unfamiliar with resolving hotkey conflicts, please visit Resolving hotkey conflicts with Apps.

	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Pass next key to application
	LEFT CONTROL + 7
	CAPS LOCK + 3

	Toggle hotkeys on off
	LEFT CONTROL + 8
	LEFT SHIFT + CAPS LOCK + 3



Open, saving, printing, and closing workbooks
	Command
	Hotkey

	Create a new workbook
	CONTROL + N

	Open the "Open" dialog box
	CONTROL + F12

	Open the "Save As" dialog box
	F12

	Save changes to the current document
	CONTROL + S

	Open the "Print" options 
	CONTROL + P

	Switch to next open workbook
	CONTROL + F6

	Switch to previous open workbook
	Control + shift + f6

	Close the current workbook
	CONTROL + F4 or CONTROL + W

	Close Excel
	ALT + F4



Navigating elements including Ribbon, Task Pane, and Status Bar
	Command
	Hotkey

	Move focus to next main element
	F6

	Move focus to previous main element
	SHIFT + F6

	Move focus to the Ribbon tab
	ALT or F10

	Move focus to a specific Ribbon tab
	ALT + Ribbon tab key (for example ALT + H to move to the Home tab, ALT + N to move to the Insert tab, etc.

	Open the context menu
	SHIFT + F10 or APPLICATION KEY

	Move focus to the previous group in the Ribbon
	CONTROL + LEFT ARROW

	Move focus to the next group in the ribbon
	CONTROL + RIGHT ARROW

	Explore commands
	Arrow Keys or TAB / SHIFT + TAB

	Move focus to the Quick Search box to enable searching for Ribbon commands
	ALT + Q

	Close Task Pane
	Press F6 to move focus to the Task Pane, then CONTROL + SPACEBAR to open the task pane menu, and select "Close"



[bookmark: _Hlk141869337]Useful SuperNova and Dolphin ScreenReader Ribbon, Task Pane, and Status Bar commands
	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Speak focus
	NUMPAD 0
	CAPS LOCK + UP ARROW

	Speak additional focus information, describes help text and shortcut key for current Ribbon command
	LEFT SHIFT + NUMPAD 0
	LEFT CONTROL + CAPS LOCK + UP ARROW

	Speak shortcut key
	LEFT SHIFT + NUMPAD PERIOD
	LEFT CONTROL + CAPS LOCK + LEFT ARROW

	Speak status bar information
	NUMPAD 2
	CAPS LOCK + PAGE DOWN

	List commands in the Quick Access Toolbar
	CAPS LOCK + Q
	CAPS LOCK + Q


[bookmark: _Hlk141437315]
[bookmark: _Hlk141438045]Tip: The shortcut key for a Ribbon tab, and the descriptive text for Ribbon commands, are automatically announced when using a High Verbosity Scheme. You can adjust your Speech Verbosity Scheme by pressing CAPS LOCK + EQUALS or, if you are using the Laptop Universal hotkey set, press CAPS LOCK + V.
To change your Braille Verbosity Scheme, press LEFT SHIFT + CAPS LOCK + EQUALS OR, if you are using the Laptop universal Hotkey Set, press LEFT CONTROL + CAPS LOCK + V.

Basic commands for navigating and selecting cells in a worksheet
	Command
	Hotkey

	Move focus to next cell
	Arrow Keys

	Move focus to next cell in row
	TAB

	Move focus to previous cell in row
	SHIFT + TAB

	Move focus to next cell in column
	ENTER

	Move focus to previous cell in column
	Shift + ENTER

	Move focus to edge of data region
	CONTROL + Arrow Keys

	Move focus to first cell in row
	HOME

	Move focus to first cell in worksheet
	CONTROL + HOME

	Move focus to last cell in worksheet
	CONTROL + END

	Scroll down
	PAGE DOWN

	Scroll up
	PAGE UP

	Scroll one page to the left
	ALT + PAGE DOWN

	Scroll one page to the right
	ALT + PAGE UP

	Go to a cell using the "Go To" dialog box
	CONTROL + G (Or F5), enter the cell co-ordinates, and press ENTER

	Go to next worksheet
	CONTROL + PAGE DOWN

	Go To previous worksheet
	CONTROL + PAGE UP

	Go to a specific worksheet using the SuperNova and Dolphin ScreenReader Item Finder
	CAPS LOCK + TAB, open the "Sheets" list, and select the sheet

	Select cells
	SHIFT + Arrow Keys

	Select a data range
	Position the focus inside the range and press control + A

	Select AN ENTIRE WORKSHEET
	Control + a or control + SHIFT + SPACEBAR (may require multiple presses)

	Select data in a column
	move focus to the first cell in the column and press CONTROL + SHIFT + DOWN ARROW. Repeat to extend selection to bottom of column.

	Select data in a row
	move focus to the first cell in the row and press CONTROL + SHIFT + RIGHT ARROW. Repeat to extend selection to end of row.

	Select entire column
	CONTROL + SPACEBAR

	Select entire row
	SHIFT + SPACEBAR

	Select using the "Go To" dialog box
	CONTROL + G (Or F5), enter the cell co-ordinates for the first and last cell in the range, separating them with a colon, and press ENTER. For non-adjacent selections, separate each range with a comma (e.g. A1:A5, C1:C5)

	Enable Selection Mode
	F8

	Extend selection when using Selection Mode
	Arrow Keys

	Enable non-adjacent cell selection
	Shift + f8

	Cancel Selection Mode
	ESCAPE



Useful SuperNova and Dolphin ScreenReader commands when navigating and selecting cells
	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Speak focus
	NUMPAD 0
	CAPS LOCK + UP ARROW

	Speak row and column headings
	NUMPAD 3
	LEFT SHIFT + CAPS LOCK + LEFT ARROW

	Speak selected text
	NUMPAD 1
	LEFT SHIFT + CAPS LOCK + DOWN ARROW

	Speak additional focus information to review co-ordinates of Selected range
	LEFT SHIFT + NUMPAD 0
	Left control + caps lock + up arrow

	Speak where am I?
	NUMPAD 7
	CAPS LOCK + PAGE UP



Tip: The Speak focus hotkey provides additional information when pressed multiple times. When press twice, the cell content is spelt, a third press spells the cell content phonetically, and a fourth press describes the character attributes of the text within the cell.

Working with cells
Excel includes a wealth of keyboard commands that make working with cells a productive experience when using the keyboard. 
	Command
	Hotkey

	Edit current cell
	F2

	Insert line break within a cell
	ALT + ENTER

	Cancel cell editing
	ESCAPE

	Copy cells
	CONTROL + C

	Cut cells
	CONTROL + X

	Paste cells
	CONTROL + V

	Open the "Paste Special" dialog box
	CONTROL + ALT + V

	Undo last action
	CONTROL + Z

	Redo last undo 
	CONTROL + Y

	Insert current date
	CONTROL + SEMI COLON

	Insert current time
	Control + SHIFT + SEMI COLON

	Insert worksheet before current sheet
	SHIFT + F11

	Switch between displaying cell values or formulas in the worksheet.
	CONTROL + grave accent

	Insert a hyperlink
	CONTROL + K



Formatting cells
Excel includes keyboard commands that enable you to change the formatting of text quickly and easily with the keyboard.
	Command
	Hotkey

	Make text bold
	CONTROL + B

	Make text italic
	CONTROL + I

	Make text underlined
	CONTROL + U

	Make text strikethrough
	CONTROL + 5

	Apply an outline border to the selected cells.
	CONTROL + SHIFT + 7

	Remove an outline border FROM the selected cells.
	CONTROL + SHIFT + MINUS

	Open the "Format Cells" dialog box
	CONTROL + 1

	Open the "Format Cells" dialog box and show the "Font" tab
	CONTROL + SHIFT + F or CONTROL + SHIFT + P



---
Tip: You can automate the announcement of style changes such as bold, italic, and underlined, through the "Prompt Areas" tab of the "Text Style Announcements" dialog box in the SuperNova and Dolphin ScreenReader Control Panel. You may find this useful when reviewing a worksheet for format changes.

Useful SuperNova and Dolphin ScreenReader commands for reviewing cell properties 
You can review the properties assigned to a cell using the SuperNova and Dolphin ScreenReader Announce Cell Properties options.
	Command
	Hotkey

	Speak cell properties
	CAPS LOCK + C

	Show cell properties in a popup edit box
	LEFT SHIFT + CAPS LOCK + C

	Open "Cell Properties Configuration" dialog box from which you can choose the properties to be announced
	LEFT CONTROL + CAPS LOCK + C



Useful SuperNova and Dolphin ScreenReader commands for reading headings and tables
SuperNova and Dolphin ScreenReader includes useful Speak keys you can use when working in tables.
	Command
	Desktop NUMPAD Hotkey Set
	Laptop Universal Hotkey Set

	Speak row and column co-ordinates
	NUMPAD 3
	LEFT SHIFT + CAPS LOCK + LEFT ARROW

	Speak row and column headings (if undetected, unknown is stated)
	CAPS LOCK + H
	CAPS LOCK + H

	Show row and column headings in a popup edit box
	LEFT SHIFT + CAPS LOCK + H
	LEFT SHIFT + CAPS LOCK + H

	Open "Heading Announcement Configuration" dialog box
	CAPS LOCK + X
	CAPS LOCK + X

	Speak column (restricted to visible cells)
	CAPS LOCK + NUMPAD 6
	SHIFT + CAPS LOCK + RIGHT ARROW

	Speak column from current cell (restricted to visible cells)
	CAPS LOCK + NUMPAD PERIOD
	SHIFT + CAPS LOCK + PAGE DOWN

	Speak column to current cell (restricted to visible cells)
	CAPS LOCK + NUMPAD 3
	SHIFT + CAPS LOCK + PAGE UP

	Speak row (restricted to visible cells)
	CAPS LOCK + NUMPAD 0
	SHIFT + CAPS LOCK + UP ARROW

	Speak row from current cell (restricted to visible cells)
	CAPS LOCK + NUMPAD 2
	SHIFT + CAPS LOCK + END

	Speak row to current cell (restricted to visible cells)
	CAPS LOCK + NUMPAD 1
	SHIFT + CAPS LOCK + HOME



Other useful SuperNova, Dolphin ScreenReader, and Excel keyboard commands
Here is a list of assorted commands you may find helpful when working in Excel.
	Command
	Hotkey

	Open the "Insert Cells" dialog box
	CONTROL + SHIFT + EQUALS

	Open the "Delete Cells" dialog box
	CONTROL + SHIFT + MINUS

	Insert row (moving current rows down)
	SHIFT + SPACEBAR to select entire row and then press CONTROL + SHIFT + EQUALS

	Insert Column (moving current columns left)
	CONTROL + SPACEBAR to select entire column and then press CONTROL + SHIFT + EQUALS

	Delete rows (moving current rows up)
	SHIFT + SPACEBAR to select entire row and then press CONTROL + MINUS

	Delete columns (moving current columns left)
	CONTROL + SPACEBAR to select entire column and then press CONTROL + MINUS

	Hide rows
	CONTROL + 9

	Hide columns
	Control + 0

	Unhide rows and columns
	Select cells spanning the hidden rows or columns and press ALT + H, O, U to access Ribbon commands.

	Hide worksheet
	ALT +_ H, O, U, S

	Unhide worksheet
	ALT + H, O, U, H and select "OK" to confirm

	Apply simple filter
	SHIFT + F10, E

	APPLY simple sort
	Shift f10, O

	Apply filter drop-down to column headings
	CONTROL + SHIFT + L

	Re-apply sort query
	CONTROL + ALT + L

	Open "Insert Function" dialog box
	SHIFT + F3

	Cycle through relative and absolute formula values
	Select cell co-ordinates in formula and press F4

	Add a new comment to a cell 
	SHIFT + F10, M

	Post comment (Excel 365 only)
	CONTROL + ENTER

	Open Comments Pane to review and reply to comments
	ALT + R, H, 1

	Insert Note in Excel 365 or Insert Comment in other Excel editions
	SHIFT + F2, enter text, and then open context menu and select "Exit edit text" when done to return focus to worksheet

	Select all cells containing Notes (or Comments when using other Excel editions)
	Control + SHIFT + O

	Create and insert Default chart type in current worksheet
	Select data range and press ALT + F1

	Create and insert default chart type in new Chart Sheet
	Select data range and press F11

	Spell check a worksheet
	F7

	Look up current word in Thesaurus
	SHIFT + F7

	Open the "Find" option
	CONTROL + F

	Open the "Go to" option
	CONTROL + G

	Open the "Replace" option
	CONTROL + H

	Continue your search in the worksheet window
	F4

	Create table
	CONTROL + T

	Open SuperNova and Dolphin ScreenReader Item Finder to view a list of links, objects, sheets, etc. in the workbook
	CAPS LOCK + TAB

	Open SuperNova and Dolphin ScreenReader Item Finder to view a list of links
	CAPS LOCK + 1

	Open SuperNova and Dolphin ScreenReader Item Finder to view a list of objects
	CAPS LOCK + 3 (or LEFT SHIFT + CAPS LOCK + 1)

	Open SuperNova and Dolphin ScreenReader Item Finder to view a list of sheets
	CAPS LOCK + 5 (or LEFT SHIFT + CAPS LOCK + 8)

	Open SuperNova and Dolphin ScreenReader Item Finder to view a list of visible cells with comments (notes)
	CAPS LOCK + 7 (or LEFT SHIFT + CAPS LOCK + 7)

	Open SuperNova and Dolphin ScreenReader Item Finder to view a list of charts
	LEFT SHIFT + CAPS LOCK + 3

	Open SuperNova and Dolphin ScreenReader Item Finder to view information about the active chart (requires chart to be selected)
	LEFT SHIFT + CAPS LOCK + 4

	Open SuperNova and Dolphin ScreenReader Item Finder to view a list of visible cells with formula
	LEFT SHIFT + CAPS LOCK + 5

	Open SuperNova and Dolphin ScreenReader Item Finder to view a list of visible cells with data
	LEFT SHIFT + CAPS LOCK + 6
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